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Chapter

INTRODUCTION

This Quick Start gives a brief overview of using the different components in MATFOR
version 4. Language considerations, the structure of programs, and the use of
advanced tools are all covered.

l. PRODUCT DESCRIPTION

MATFOR is a set of numerical and visualization libraries developed to enhance
programming in C++ and Fortran environments. Especially designed for scientists
and engineers, MATFOR aims to accurately perform computation, dynamically
visualize data, and efficiently decrease process time. Its features include:

mfArray, a MATFOR defined data type that simplifies and facilitates
object-oriented programming in C++ and Fortran environments.

Numerical Library contains useful linear algebraic functions subject to assist
users with computational problem solving.

Visualization Library collects well-designed graphical procedures and controls
to support a variety of 2D and 3D visual functions.

Data Viewer, organized in spreadsheet format, is one convenient platform for
data management, filter, and analysis.

Graphics Viewer, besides its highly customized user interface, overthrows the
convention of post-processing as it instantly visualizes scientific and engineering
data.

mfPlayer animates simulation results by reading and displaying numerical data,
and further allows additional graphical manipulations.

Graphics Export converts dynamic presentation into standalone movie or image
files to enhance accessibility of simulation results.

GUI System facilitates application-building by allowing users to create an
interface of their preference.
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COMPILER REQUIREMENTS

MATFOR supports these compiler choices:

Platform and System Requirements

Platform Operating System Fortran Compilers

+ Compag Visual Fortran 6.6 C

Intel Based . ¢ |Intel Visual Fortran 8.1/9.0/9.1
32-bit systems Windows 2000/ XP ¢ Lahey Fortran5.7/7.1
+ Absoft Fortran 9.0/10.0
FedoraCore 1/2/3/4
Red Hat Enterprise Linux 3.0/ 4.0 ¢ Intel Fortran 8.1/9.0/9.1
Intel Based

32-bit systems

White-Box Enterprise 3 Lahey Fortran 6.2c

SuSE 9.1 Enterprise + Absoft Fortran 9.0/10.0
Mandrake 10

*

EM64T/AMD64
64-bit systems

Fedora Core 2/3 ¢ |Intel Fortran 8.1/9.0/9.1
Red Hat Enterprise Linux 4.0 Absoft Fortran 10.0
+ PathScale 2.4

*

Due to constant updates of the compilers, these requirements are subjected to
change without further notice. Please refer to the latest version of compiler
requirements at http://www.ancad.com/requirements.html.

INSTALLATION

This section provides step-by-step instructions for installing MATFOR. If you
encounter any problems during the installation, please contact support@ancad.com.

WINDOWS INSTALLATION

e Pre-Installation

p wDdPF

Exit any of MATFOR programs executing;

Remove all previous versions of MATFOR components if this is an upgrade;
Ensure the Compiler Requirements are satisfied;

Obtain administrator rights under Windows 98/2000/NT/XP.

* Begin Installation

1.

Insert the MATFOR CD into the CD-ROM drive.

The standard MATFOR Installation Procedure shall start automatically. If the
Procedure fails to start, you may manually start it by double-clicking on the
MATFOR.exe file under the <CDROM>\Content\ path.

Follow the self-explanatory instructions in the Procedure to set up all
MATFOR components.

Specify a destination folder to create MATFOR through the Procedure.
By default, the Package creates a program group in your C drive under the


http://www.ancad.com/requirements.html
mailto:support@ancad.com
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path C:\Program Files\AnCAD\MATFORA4\.

e Set Environment Path

The Procedure automatically sets the $PATH and $MATFOR4DIR environment
variables.

To manually set the environment variables:

1.
2.

Go to Control Panel\System.

In the System Dialog Box, select the Advance label and click on the
Environment Variables tab.

In the System Variables Box, add <MATFOR4>\bin and <MATFOR4>\tools
to the [path] variable.

NOTE
<MATFOR4> shall specify the directory under which MATFOR s installed.
i.e. C:\\Program Files\AnCAD\MATFOR4

LINUX INSTALLATION

e Pre-Installation

o o M w NP

Exit any of MATFOR programs executing.

Remove all previous versions of MATFOR components if this is an upgrade.
Ensure the OS Requirements are satisfied.

Ensure the Compiler Requirements are satisfied.

Obtain root rights under Linux OS.

Run the ‘rpm —ivh compat-libstdc++-33-3.2.3-47.3.i386.rpm’ command to
install the compat-libstdc++-33 package. (Optional)

* Begin Installation

Open a command shell.

Change the current directory to the one containing the
matfor_f-4.xx-i686.rpm Installer.

Run the ‘rpm —ivh matfor_f-4.xx -i686.rpm’ command.

Follow the self-explanatory instructions in the Procedure to set up all
MATFOR components. By default, the Installer creates a program group
under the path /usr/lib/matfor4.

* Environment Path Settings

The Procedure automatically sets the $PATH and SMATFOR4DIR environment
variables.
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To manually set the environment variables:
1. Add the following lines to your ~/.bashrc file.

2. export MATFOR4DIR=/usr/lib/matfor4
export LD_LIBRARY_PATH=3$MATFORA4DIR/lib:$LD_LIBRARY_PATH
export PATH=$MATFOR4DIR/tools:$PATH

3. Runthe ‘source ~/.bashrc’ command or re-login your system.

IV. REGISTRATION

At the end of installation, you are required to enter the License Password for
registration, which can only be obtained by submitting the Host ID of your local
machine to AnCAD, Inc.

1. Go to http://www.ancad.com/activation.php to activate MATFOR product with the
Serial Number and Host ID information.

2. MATFOR license key should be sent to you through the email provided within 24
hours.

(Note: trial users may receive trial keys via email upon the receipt of download
request. Please go to http://webphp/download.php to submit your request.)

UNDER WINDOWS

The registration program can be launched from Start » Program Files p>
MATFOR4 P Utilities > Register MATFOR 4 in Fortran (or C++)

UNDER LINUX
o« Go to /usr/lib/matfor4d/tools.

« Type .reg_xxx to launch the registration program.

V.  FLOATING LICENSE & CLASSROOM LICENSE

To enable a group of developers to share a pool of licenses more efficiently, MATFOR
supports floating licenses and classroom licenses for cross-system/cross-platform
environments. The floating license is designed to be used in any shared network
environment, and the classroom license is designed for the purpose of teaching in an
academic environment. Any project developed under MATFOR classroom license
may not be redistributed to a third party with profit interest or being a commercial
institution.


http://www.ancad.com/activation.php
http://webphp/download.php
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These license models consist of one or more license servers; the license server runs
the license management process and monitors number of concurrent users using
MATFOR licenses in the network. The installation steps are:

WINDOWS INSTALLATION

¢ |nstallation of License Servers

1.

Run license_server.exe (download from http://www.ancad.com/activation.php)
on machines designated as license servers.

Retrieve required information from the machine.
Under command prompt,

i.  Change directory to C:\Program Files\AnCAD\License Server.
ii. Execute Imtools to get Ethernet Address and Host Name.
Collect the following product information:

i. ~ Compiler version

ii. Operating system

iii. Number of license of each version

Obtain license file(s) for license server(s).

i. Go to http://www.ancad.com/activation.php to activate MATFOR with the
Serial Number and Host ID information.

ii. The license file(s) should be sent to you through the email provided within
24 hours.

5. Place the license file xxx.lic into <AnCAD=>\License Server directory.

6. To start the license server.

Under command prompt, type:
Imgrd —c xxx.lic or
Imgrd —c . for multiple license files.

* Configuration in Client Computers

1.

Install MATFOR on machines designated as clients.

2. Go to Start P> Program Files » MATFOR4 P Utilities P Register MATFOR.
3.
4. Fillin the Host Name or IP Address of the license server in the blank area. (IP

Under Registration Window, choose Network License.

Address can be obtained from the license server by typing Imhostid
-internet —n under command prompt.)

LINUX INSTALLATION


http://www.ancad.com/activation.php
http://www.ancad.com/activation.php
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¢ |nstallation of License Servers

1. Run license server executable file (download from
http://www.ancad.com/activation.php) on machines designated as license
servers.

tar zxf license_server.tar.gz —c /usr/lib

2. Retrieve required information from the machine.
Under command shell,

i. Goto/usr/lib/matfor_licsvr

ii. Type ./Imhostid —n to get Ethernet Address.

iii. Type ./Imhostid —hostname —n to get Host Name.
3. Collect the following product information:

i.  Compiler version

ii. Operating system

iii. Number of license of each version
4. Obtain license file(s) for license server(s).

i. Go to http://www.ancad.com/activation.php to activate MATFOR with the
Serial Number and Host ID information.

ii. The license file(s) should be sent to you through the email provided within
24 hours.

5. Place the license file xxx.lic into /usr/lib/matfor_licsvr directory.
6. Start the license server.

Under command prompt, type:

Imgrd —c xxx.lic or

Imgrd —c . for multiple license files.

* Configuration in Client Computers
1. Install MATFOR on machines designated as clients.
2. Goto /usr/lib/matfor4 and type ./reg_xxx
3. Under Registration Window, choose Network License.
4

. Fill in the Host Name or IP Address of the license server in the blank area. (IP
Address can be obtained from the license server by typing Imhostid
-internet —n under command shell.)

For other questions regarding MATFOR floating license or classroom license
installation and registration, please contact support@ancad.com.



http://www.ancad.com/activation.php
http://www.ancad.com/activation.php
mailto:support@ancad.com
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PROJECT SETTINGS

Due to the variety in MATFOR-supporting compilers, this chapter is composed to
guide users to configure project settings under different compiler environments.

IN WINDOWS

Chapter

COMPAQ VISUAL FORTRAN

1. Open Compaq Visual Fortran Developer Studio.

Go to File > New.

Select the project type Fortran Console Application.

2
3
4. Enter a name for the new project, specify its location, and click OK.
5

Select An empty project and click Finish.

Files Projects | Workspaces | Other Documents |

.27 ATL COM AppWizard
[%|Cluster Resource Type Wizard
g Custom AppWizard
[ZnDatabase Project

I DevStudio Add-in Wizard

BrrraTT ; ry
|=]Fortran Standard Graphics or QuickWin Application
¥ |Fortran Static Library
|=1Fortran Windows Application

MFC ActiveX Control¥izard
[&] MFC AppWizard [dIl)
MFC AppWizard [exe]
$XNew Database Wizard
1 Utility Project
=a|Win32 Application

<

T1win32 Cor Project name:

%] Win32 Dyr_fdemo1
Location:

| Win32 St
IC:\demo1

& Create new workspace
5 Add to| currentworkspace
I=| Dependency; of:

Platforms:

[VWin32

|

Cancel

o]
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1. Select Settings from the Project menu.

2. Click on the Fortran tab and select Preprocessor from the Category menu.

3. Under INCLUDE and USE Paths, type in: $(MATFOR4DIR)\include\cvf

Project Settings

Settings For:

¥Win32 Debug

Eredefined Preprocessor Symbols:

j General | Debug | Fortran | CiC++ | Link | Flesui EE

Catﬁ!]ﬂf!'q Ereprucessur > j Beset |

2l x|

Default INCLUDE and USE . -

Paths: ISuurcc Directory * J

Module Path: INCLUDE and USE Paths:
e Al o Talls-

" Use FPP
I” Preprocessor Symbols to FPP Only

Project Options:

Debug/ QMOmmRnincw

fcheck:bounds Jcompile_only /dbglibs }debug:full
finclude:"S[MATFORADIR\include\cvf’ fnologo
ftraceback jwarn:argument_checking fwarn:nofileopt

[

OK I Cancel

Click on the Link tab and select Input from the Category pull-down menu.
5. Under Object/Library Modules, add: fml.lib fgl.lib (and spml.lib if using

MATFOR Sparse Array)

6. Under Additional library directories, type in: (MATFOR4DIR)\lib\cvf
e

Settings For:

Win32 Debug

j General | Debug | Fortran | ClC++ | Link | Flesug EE

Catcgu&: i|nput ) j Reset |

| ~Bbjeriiibrag modules:
¢ fmil.lib fgl.lj rmel32.lib user3d2.lib gdi32.lib winspool.lib
Ignore libraries: [” Ignore all default libraries

Force symbol references:

Wﬂﬂh\
<\|§|MATFOR4DIR]\Iih\ﬁ )
Project Options:

fml.lib fgl.lib kernel32.lib user32.lib gdi32.lib i’
winspool.lib comdlg32.lib advapi32.lib shell32.lib
ole32.lib oleaut32.lib uuid.lib odbc32.lib odbccp32.lib i

0k | Cancel |
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II. INTEL VISUAL FORTRAN
Open Microsoft Visual Studio 2005.
Go to File » New Project.

1

2

3. Select Intel® Fortran Projects from the Project Types menu.

4. Select Console Application from Templates and type a solution name.
5

Enter a name for the new file and click OK.

Templates:
Yisual Studio install

[ Console Application £ 1, Dymande-link Library
- aton £, Static Library
o Visual 18 71, Windows Application
(- Visnal C+
], OibiessBverd My Templates

) Fortran Pjects .
L Search Online Templates...

Hame:
Location: ;I Browss. .. |
Solution: o reate SIE ¥ Create directory for solution
Solution Name: [femol | [ Add o Somrce Control
0K I Cancel
6. Click on Finish.
7. Select Properties from the Project menu.
8. Go to General under the Fortran folder.
9. In Additional Include Directories, type in: $(MATFOR4DIR)\include\if9
demol Proper
Configuration: |ﬁCﬁV9(D3bU\%) | Blatform: |Acﬁve(Wi.n_32) ~|  Configuration Manager... |
£ Configuration Properties Suppres: Startup Banner Yes
- General Additions] Inchud -
Debug Information Format
Optimization Disable
; Preprocessor Definitions
5 E;‘;“ﬁér Compile Time Disgnastics Customn
- Code Generation
.. Language
. Compatibility
.. Diagnostics
. Data,
. Flnating Point
- External Procedures
.. Output Files
.. Bun-time
- Libraries
- Comumand Line
[+ Linker
[+ Resoumes
- MIDL
[+ Build Events
- Custom Build Step Additional Include Directories
Specifies one or more directories to add to the include path. Tse a semicolon or comma delimited list if
more than one. {finclude:path)
0K I Cancel Apply
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10. Go to General under the Linker folder.

11. In Additional Library Directories, type in: $(MATFOR4DIR)\lib\if9

demol Property

Confignration: | ActiveDebug) (= Platform: | Active (Win32) | Configuratinn Manager. . |
2 Configuration Properties Ctput File $(OUTDIR)demol exe

geEeral_ Show Progress ot Set
- Debugging .
[+1- Fortran iecion
- Ljads Enable Incremental Linking No

; : Suppres Startup Banner Yes

Manifest Fils Iznore Import Libracy Ho

Additional Library Directories

(M A TFOR4DIR )Alib\if9

-Embedded IDL
- Advanced

- Besources

- MIDL

- Build Events

- Custom Build Step

Additional Library Directories
Specifies one or more additional paths to search for libraries; configuration specific; we wmi-colon
delimited list if more than one. (LIBPATH[Air])

0K | Comel | Apply |

demol Property

Confignration: IActivelfDebug) LI Platfomm: IAcﬁve(WhﬁE) LI Configuration Manager... |
P ——

Ad

A Configuration Properties di
Iznore All Default Libraries

- (remeral

i E;I_’tm“%fmg Tgnore Specific Library

&} Linker Moduls Definition Fils
- e Add Moduls to Assembly
@ e Embed Managed Resource File

: bu.g Force Symbol References

- Bstemn Delay Loaded DLLs
- Optimization
-Embedded [DL
i Adwanced

- Resourmes

- MIDL

[+]- Build Events

- Custom Build Step

Additional Dependencies
Specifies additional items to add to the link line (gx: kemnel 32 1ib); configuration specific.

QK I Caneel Apply

12. Go to Input under the Linker folder.

13. In Additional Dependencies, add: fml.lib fgl.lib (and spml.lib if using
MATFOR Sparse Array)



14 MATFOR QuUICK START

lll. LAHEY FORTRAN

Lahey 5.7 Fortran users

1.
2.

Open Lahey Fotran 95 Console Prompt.
Type in the following command to compile the codes:

[f95 -i “<MATFORDiIrectory>\include\lf” -libpath
“<MATFORDirectory>\lib\If” -lib fml.lib fgl.lib spml.lib mxui.lib mxuiF.lib
<fileName>

NOTE

<MATFORDirectory> shall specify the directory under which MATFOR is
installed. <fileName> shall specify the name given to the file. For
example,

If95 -i “c:\progra~1\ancad\matford\include\lf” —libpath
“c:\progra~1\ancad\matford\lib\If” -lib fml.lib fgl.lib spml.lib mxui.lib
mxuiF.lib test.f90

Lahey 7.1 Fortran users

1. Select Properties from the Project menu.

2. Select Module/Include file paths under the Fortran label.

3. In Search Path for Module Files, type in MATFOR Module install path, for
example,
C:\Program Files\AnCAD\MATFORA\include\LF

ConsoleApplication] Froperiy Pages E|

Configuration; |Active(Debug) | Platform; |Active(Win32) | Configuration Manager...

|

) Configuration Properties =]

{23 Fortran Search Path for Module Files eram Files\AnCADAM A TFOR4\includeALF |
Creneral

(3 Linker

Greneral Search Path for Inclode Files

DebugDiagnnsticaT
Cornpiler Output
iy
(Optimization
Precision
Comumand Line

Search Path for Module Files

Specify pathiz) for ssarching for previously compiled LFI5 MODTLE files { MOD).
Separate multiple search paths with a smicolon.

|

Ok | Cancel Apply
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4. Select General under the Linker label.

5. In Additional Library Directories, type in: C:\Program
Files\AnCAD\MATFORA4\lib\LF

ConsoleApplication] Property Fages

Configuration; | &ctive(Debug)

v | Blatform; | Active(Win32)

il

Configuration Manager. .. |

3 Configuration Properties B
Creneral Cutput Path and/for Filename
(23 Fortran Additional Library Directories CAProgran Files\bnC ADRLA TF@
23 Linker Static Link Runtime Libraries Troe
¥ Grenerate Map File True
PHITHAE e Show Compilsr Options Falss

Additional Library Direciones
Specifies one or more additional paths to search for libraries; configuration specific; vse
sd-colon delimited list if move than one.

Ok | Cancel Apply

6. Select Command Line under the Linker label.
7. In Additional Options, type in: fml.lib fgl.lib spml.lib mxui.lib mxuiF.lib
X

ConsoleApplication] Property Pages

Configuration; |Ac1:ive (Debmg) ﬂ Platform: |f"fol\"E (Mrin32) ﬂ Configuration Manager... |
25 Contiguration Properties Additions] Options:
Creneral Cfpnl Lib fel lib spl lib momd ib moodF L]
(Z3 Fortramn
ok | cancel Apply
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IV. ABSOFT FORTRAN

1. Open Absoft Fortran Development Command Prompt.

2. Copy win_abf template.mak from <MATFOR4>\tools\template to the
directory of the project.
(Note: users of version 10 shall use win_abf10_templat.mak.)

3. Rename the make file to win_abf.mak.
4. Modify win_abf.mak as required.

5. Type nmake —f win_abf.mak to build and compile the project.

IN LINUX

V. ALL COMPILERS

1. Open Command Prompt.

2. Copy linux_xxx_template.mak from /usr/lib/matfor4/tools/template to the
directory of the project.

3. Rename the make file to linux_xxx.mak.

4. Modify linux_xxx.mak as required.

5. Type make —f linux_xxx.mak to build and compile the project.

TO RUN A DEMO CASE

UNDER WINDOWS

1. Go to the directory where MATFOR 4 is installed.
2. Opendemol/ fortran/<demo case>.

3. Select the .dsw file to run the demo case.

UNDER LINUX

1. To compile demo cases all at once, go to /usr/lib/matfor4/demo/fortran

To compile each demo case individually, go to
lusr/lib/matfor4/demo/fortran/<demo case>.

Type make —f linux_if9.mak

Go to the /usr/lib/matfor4/demo/fortran/<demo case> to run each demo
case. For example,

cd SMATFOR4DIR/demo/fortran/3dplot
/3dPlot
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Chapter

FUNDAMENTALS

This chapter is an introductory summary on how to integrate MATFOR into Fortran
programming.  Beginning with mfArray, the core of MATFOR, the chapter
subsequently introduces the numerical library and the visualization library.

l. MFARRAY
mfArray is a dynamic array endorsing the data types and dimensions listed in Table

3.1.

Data Type Statement
character a="~A
character(*) a = ‘string’
Logical a = .true.

Integer a=1

real(4) a=1.0

real(8) a =3.1418d0
complex(4) a=(2.0,3.0)
complex(8) a = (2.0d0, 3.0d0)

Table 3.1 | mfArray Data Types

mfArray Declaration
1. Use MATFOR module to appropriately contain mfArray.
2. Declare mfArray using the format type(mfArray) ::<variable>
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Example Code (ch3-1)
Program Main

use fml I Use module fml
implicit none

type(mfArray) :: X,y I Declare mfArray variables x and y

X =6.0d0 I x is a scalar
y =(/1.0, 2.0, 3.0, 4.0, 5.0/) ! y is a 1-by-five vector containing real values

call msDisplay(x, ‘x’,y, ‘'y’) ! Call msDisplay subroutine to display x and
y data

end Program Main

Result

Il NUMERICAL PROCEDURES

MATFOR embraces a comprehensive set of numerical procedures furnished with
easy-to-call syntax to complement mfArray. Various categories of numerical
procedures are contained in the set and are hereto listed in Table 3.2.

For a complete list of the numerical routines and descriptions on their usage and
functionality, please refer to the Reference Guide.
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Procedure Group Example Description

Data Manipulations mfSort Sort data in ascending order

Arithmetic Operators mfRDiv Right-divide the matrix

Trigonometry mfCos Request cosine function

Exponential mfLog Request natural logarithm

Complex mfConj Generate conjugate of
complex

Rounding and Remainder mfCeil _Ro_u_nd towards positive
infinity

Matrices mfMagic Construct magic square

Matrix Manipulations mfFind Find indices of nonzero
elements

Matrix Analysis mfNorm Generate matrix/vector norm

Linear Equations mfChol Requ_est _Cholesky
factorization

Eigenvalues and Singular Perform Schur

mfSchur o
Values decomposition
Factorization Utilities mfBalance Perform diagonal scaling

Table 3.2 | Numerical Procedure Brief

Numerical Procedure Call
1. Use fml to appropriately contain the numerical routine(s).
2. To retrieve the procedure:
- If the procedure is a function, use the assignment operator “=";

- Else, if the procedure is a subroutine, retrieve the subroutine by
using call.

Example Code (ch3-2)
Program Main

use fml I Use module fml
implicit none

type(mfArray) :: m, i, j I Declare mfArray variables m, i, and j
m = mfMagic(3) I Construct a 3-by-3 magic matrix and assign it
tom

call msFind(mfOut(i, j), m) ! Retrieve the row-column indices of the
nonzero(s) in m

I'i and j describe the row and column,
respectively

call msDisplay(m) I Display matrix m
call msDisplay(i, ‘i’, j, /J') ! Display the row-column indices of the
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nonzero(s)

end Program Main

Result

. VISUALIZATION PROCEDURES

In addition to the numerical procedures, MATFOR endorses a collection of
visualization routines to enhance data comprehension. Table 3.3 summarizes the
procedures and introduces an example routine with description for each procedure

group.

Procedure Group Example Description

Set the frame size of Graphics
Viewer window

Visualization Controls mfSubplot Create subplot in active figure
Graph Options mfSurf Construct 3D surface plot

Advanced Graph Construct 3D Delaunay
Options triangulation

Object Manipulations  mfObjOrigin Set the origin of the drawn object

Specify the colormap type of the
drawn object

Annotations mfTitle Annotate the graph with title
3D Objects mfSphere Draw a sphere

Window Management mfWindowSize

mfGetDelaunay3

Appearance Settings  mfColormap

Table 3.3 | Visualization Procedure Brief

For a complete list of the visualization routines and descriptions on their usage and
functionality, please refer to the Reference Guide.

Visualization Procedure Call
1. Use fgl to appropriately contain the visualization routine(s).
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2. To retrieve the procedure:

- If the procedure is a function, use the assignment operator “=";

- Else, if the procedure is a subroutine, retrieve the subroutine by
using call.

Example Code (ch3-3)

Program Main

use fml I Use numerical routines
use fgl I Use visualization routines
implicit none

type(mfArray) :: nx, ny, nz

type(mfArray) :: X, Y, z, c, tet I Declare mfArray variables
nx = mfLinspace(-2, 2.2d0, 21) I Construct linearly spaced vector nx
ny = mfLinspace(-2, 2.25d0, 17) I Construct linearly spaced vector ny

nz = mfLinspace(-1.5d0, 1.6d0, 31) ! Construct linearly spaced vector nz

call msMeshgrid(mfOut(y, x, z), ny, nx, nz) I Construct grid matrices
for 3D plotting

c =2 *mfCos(x**2) * mfExp( — (y**2) — (z**2)) ! Mathematically define c
tet = mfGetDelaunay3(x, y, z) I Construct 3D Delaunay triangulation
call msTetSliceXYZ( tet, x,y,z, ¢, &

mf((/1.0d0, 1.0d0/)), mf(0), mf(-0.75d0) ) ! Display orthogonal sliced

planes

call msViewPause() I Pause to display the graph
call msFreeArgs(nx, ny, nz, X, Y, z, ¢) ! Deallocate mfArray

end Program Main

Result
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A FIRST PROGRAM

This chapter presents one simple visualization program for users to manipulate and
extends as animation and recording procedures are introduced.

l. HELLO SURFACE

The section shall take you step by step to create a surface plot.

Create a New Project/File

1. Select the project type Fortran Console Application.
2. Name the project “demol,” specify its location, and click OK.

7

Files Projects ] Waorksp | Other D t I
.5 ATL COM AppWizard F|Win32 App  Project name:

7| Cluster Resource Type Wizard TIwin32 Cor Agemol

a1 Custom AppWizard [=]Win32 Dy
‘= Database Project |Win32 Stg Locatian:
2 DevStudio Add-in Wizard il

pded Stared Proc Wizard : ;_J
ics or Quick¥in Application * Create new workspace
[ B

EAMFC AppWizard [exe]
% New Database Wizard Platforms:
T Utility Project ¥'¥in32
¢ | 5

0K | Cancel
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3. Select An empty project and click Finish.

Fortran Console Application - Step 1 of 1

YWhat kind of Console Application do you want to create?

" A simple project.

" A"Hello World" sample project.

- This project will be linking against one or more Fortran DLL Import
libraries.

X

< Back ‘ ‘ Finish | Cancel ‘

Help

5.

New

4. Select the file type Fortran Free Format Source File.
Name the file “demol,” specify its location, and click OK.

[ C++ Source File

2%
Files ] Projects | Workspaces | Other Documents ‘
Activc Server Page ¥ Add to project:
& Biuman rie [demot =l
1 C{C++ Header File

mol

Location:

T |DAdemo1
LiResource Script

1 Resource Template

SQL Script File

Text File

Cancel
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Adding the Source Code(ch4-1)
In “demo01.f90,"type in:

Program demol

use fml I Use numerical routines
use fgl I Use visualization routines
implicit none

type(mfArray) :: X, Y, z I Declare mfArray variables

call msMeshgrid( mfOut(x, y), & I Construct grid matrices for 3D
plotting

mfLinspace(-3, 3, 30), &

mfLinspace(-3, 3, 30))

z = mfSin(x) * mfCos(y) I Mathematically define z

call msSurf(x, y, z) I Plot a surf using mfArrays x, vy,
and z

call msViewPause() I Pause to display the graph
call msFreeArgs(x, y, z) I Deallocate mfArray

end Program demol

Line-by-Line Walkthrough

use fml
This includes the module fml which contains the MATFOR numerical procedures.

use fgl
This includes the module fgl which contains the MATFOR visualization procedures.

type(mfArray) :: X, Y, z
This declares mfArray variables x, y, and z.

call msMeshgrid( mfOut(x, y), mfLinspace(-3, 3, 30), mfLinspace(-3, 3, 30) )

This generates x and y grid matrices from the domains specified by the

mfLinspace-generated vectors. This procedure aims to solve functions for two

variables by plotting 3D graphs.

- mfOut(x, y) specifies x and y as mfArray outputs.

- mfLinspace(-3, 3, 30) constructs a vector with 30 linearly spaced points between
-3 and 3.

z = mfSin(x) * mfCos(y)
This defines z mathematically.

call msSurf(x, y, z2)
This creates a three-dimensional surface plot of the x-, y-, and z-coordinates.
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call msViewPause();
This halts program execution for graphical display. mfViewPause() should be added
after each set of graphical creation routines.

call msFreeArgs(x, Yy, z)
This deallocates the previously declared mfArray variables.

Compile and Run

Bl MATFOR 4.1 - [Figure 1] |ZHE|E‘
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Il TO ANIMATE HELLO SURFACE
In this section, the Hello Surface demo code is modified to generate animation.
Animation

Animations effects are produced by continuously updating data displayed in the
Graphics Viewer.

To Animate Data

1. Use fgl to appropriately contain the visualization routine(s).

Construct and initialize the mfArrays for plotting.

Create a static plot of the graph to be animated.

Set up an iteration loop for the range of data to be observed through animation.

o bk~ WD

Within the loop, use procedure call msGSet(handle, ‘axis-data’, data) to update
the targeted data of the current draw.

6. Update the drawn figure accordingly by using procedure msDrawNow.
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7. Use procedure call msViewPause after the end of animation to observe the static
graph.

Example Code(ch4-2)
Modify the previously created “demo1.f90” file as follows and rename it “demo2.f90™:

Program demo2

use fml I Use numerical routines
use fgl I Use visualization routines
implicit none

type(mfArray) :: xX,Y, z, h I Declare mfArray variables
integer(4) :: i I Declare an integer variable

call msMeshgrid( mfOut(x, y), & I Construct grid matrices for 3D
plotting

mfLinspace(-3, 3, 30), &

mfLinspace(-3, 3, 30))

doi=1, 10 I Create loop
z = mfSin(x+i/8.0d0) * mfCos(y) ! Mathematically define z

if i ==1) then I Plot a surf using mfArrays X, y, and z
h = mfSurf(x, y, z)
call msDrawNow
else I Update the figure as the
z-coordinate varies
call msGSet(h, ‘zdata’, z)
call msDrawNow

end if I End if
end do I End loop
call msViewPause() I Pause to display the graph
call msFreeArgs(x, Y, z, h) I Deallocate mfArray

end Program demo2

Line-by-Line Walkthrough
use fml
This includes the module fml which contains the MATFOR numerical procedures.

use fgl
This includes the module fgl which contains the MATFOR visualization procedures.

type(mfArray) :: X, Y, z, h
This declares mfArray variables x, y, z, and h.
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integer(4) :: i
This declares an integer variable i.

call msMeshgrid( mfOut(x, y), mfLinspace(-3, 3, 30), mfLinspace(-3, 3, 30) )

This generates x and y grid matrices from the domains specified by the

mfLinspace-generated vectors. This procedure aims to solve functions for two

variables by plotting 3D graphs.

- mfOut(x, y) specifies x and y as mfArray outputs.

- mfLinspace(-3, 3, 30) constructs a vector with 30 linearly spaced points between
-3 and 3.

doi=1, 10

This creates a loop running from i=1 to i=10.

z = mfSin(x +1/8.0d0) * mfCos(y)

This defines z mathematically. Note that the equation involves the loop index i.

if (i==1)then
At the beginning of the loop,
h = mfSurf(x, y, z)
This creates a three-dimensional surface plot of the x-, y-, and z-coordinates.
call msDrawNow
This displays the initial figure.

else
At all other times during loop execution,
call msGSet(h, ‘zdata’, z)
This sets the z-coordinate for update.
call msDrawNow
This displays and updates the figure during loop execution.

end if
This ends the if-else statement.

end do
This ends the loop.

call msViewPause();
This halts program execution for graphical display.

call msFreeArgs(x,y, z)
This deallocates the previously declared mfArray variables.
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Compile and Run
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[ll.  TO RECORD HELLO SURFACE

This section revises the previous sample code to perform animation
recording.

Recording

MATFOR allows recording of animated simulation to facilitate date
presentation with comprehensiveness and readability.

To Record Animation
1. Use fgl to appropriately contain the visualization routine(s).

2. Use procedures call msRecordStart(‘fanimation.omp’) and call
msRecordEnd() before and after the animation codes to record the
animation.

Example Code(ch4-3)

Add the recording routines to the previously created “demo02.f90” file and rename it
“demo3.f90” (Note: only the modified and added lines are shown in colors):
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Chapter

THE ADVANCED FEATURES

This chapter presents the innovative MATFOR 4 features that are functionally
powerful in advanced programming. The first part concerns mfPlayer, which aims to
enhance data presentation and accessibility. The second part focuses on MATFOR
Graphics Viewer which embraces a full range of manipulation functions. The last
part introduces the MATFOR GUI Builder, discussing the application-building facility
and integration capability.

l. MFPLAYER

mfPlayer is an exclusive visual tool by which the previously saved numerical data is
read and displayed. As MATFOR saves the simulated data into a MATFOR-defined
MFA file, mfPlayer is one approach to present the file as a recorded animation.

To record simulated result(s) into an MFA file, simply use procedures
msRecordStart() and msRecordEnd() before and after the animation codes to
record the animation:
call msRecordStart( 'filename.mfa’)
/[ animation codes
call msRecordEnd
To play an MFA file with mfPlayer.

1. Goto Start P Program Files » MATFOR4 P> Utilities > mfPlayer
2. Click Open File to find MFA file and click Play.
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Il GRAPHICS VIEWER

Embracing a friendly user interface, MATFOR Graphics Viewer supports a variety of

graphical manipulation functions.

Example Code(ch5-1)

Program demol

use fml I' Use numerical routines
use fgl I Use visualization routines
implicit none

type(mfArray) :: a, b, c, X,y, z

type(mfArray) ::indxi, indxj I Declare mfArray variables

a = mfLinspace(-3, 7, 51) I Construct linearly spaced vector a
b = mfLinspace(-2, 8, 51) I Construct linearly spaced vector b
¢ =mfColon(1, 51) I Construct a vector mfArray ¢

call msMeshgrid(mfOut(x, y), a, b)
call msMeshgrid(mfOut(indxi, indxj), ¢c) ! Construct grid matrices for
3D plotting

z = 3* mfSin((indxi+1)/10) &
*mfCos((indxj+1)/10) &
+ 2*mfSin((indxi+indxj)/10) ! Mathematically define z

call msSurf(x, y, z) I Plot a surf using mfArray x, y, and z

call msViewPause() I Pause to display the graph
call msFreeArgs(a, b, c, X, y, z, indxi, indxj) ! Deallocate mfArray

end Program demol
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Compiler and Run

Bl MATFOR 4.0 - [Figure 1]
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.  MATFOR GUI BUILDER

MATFOR GUI Builder allows users to create an interface of their preference,
facilitating application-building by packaging the complex codes.

To Build an Application

1. Go to Start » Program Files » MATFOR4 » Utilities and run MATFOR GUI
Builder.

Ed MATFOR GUI Builder 1.0

File Edit Toolz Window Help
D= H
THEIREC o A @ K R FEEE . e =
el @ Form1 BEER
s B esasassssss s s s ssssssssssasssaaaay
- [ Form N
ﬂZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZ
3
|DFOnn1 jZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZ
Property |"-’31U«‘3 ]
caption  [Fomml N
color #clcled | |l
height 324 L
icon (none)
name Forml
e n hd|
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Add MATFOR Window and Button.

WD

5. Set MATFOR Widget Align to alClient.

Ed MATFOR GUI Builder 1.0

Ele Edit Took Window Help
D@ v sme rE bEI | wA e & FEESS .- @
|
Qbjests -
- £ Form!
- [ attorbrintowt
Lot | utton]

Euttonl

Property Falue
align alBotiom
allowallup falze
caption Clozs

color #eee0dd
down false

flat false
fontealor #000000
glyph (nome)
groupindex | 0
height 31

name Buttonl
g 1}
wdth 546

® o

¥ 435
OnClick binClose_Click

6. Click Save.

7. Name the file “demo2.mfui” and specify its path.

8. Select the checkboxes Fortran Main and CVF 6.6 Project.

Save Query

b0 TEOE UT Form Fil(' iD:‘demoZ‘demoZ.m.fui )

Fortran Export |C++ Export I

. OOICE BXPOTT
Source Co

— Fortran Proje poit
v CYF6.6 Project [~ Inel Fortran 8.1 Project [~ Intel Fortran 9.0 Project

[~ Intel Fortran 8.1 Linu EMG4T) [ Intel Fortran 9.0(Linwx EME4 T)

— Fartran Makefile Export
[~ C¥F [~ Intel Fortran 8.1 (Win [A32) [~ Intel Fortran 9.0(Win [432)
[~ Lahey Fortran{Win L4 32) [ Intel Fortran 8.1 (Linm [A32) [ Intel Fortran 9.0(Linws [432)
[ Lahey Fortran(L i 1A 32) [~ Wbanoft Fortran(WWin [A32) [T Absoft Fortran(Linme LA 32)

Save | Cancel I

Set to alBottom; enter Close for [Caption|; and type in btnClose for Name|

Select OnClick from |[Event Handlerl and set it to btnClose_Click.
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Open the project “demo?2_cvf.dsp” and add the following code to “demo02.f90™:
Subroutine btnClose_Click(sender)
CHARACTER(*) :: sender
call exit(0)
end Subroutine btnClose_Click

Compile and Run.




